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Videoeditoinnin perusteet: Windows Movie Maker
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1. Yleista

Windows Movie Maker on Windows XP:n mukana tuleva ilmainen videoeditointiohjelma.

Movie Maker on helppo ja yksinkertainen kotikdyttdjan ohjelma, josta voi tallentaa videotiedostoja
vain Windows Media -videoksi (wmv) tai suurikokoisiksi avi-tiedostoiksi (Audio Video Interleaved).
Editoidut videot voi my0s nauhoittaa takaisin videokameran DV-nauhalle tai polttaa CD-levylle. Movie
Makerissa EI ole video-DVD:n tekomahdollisuutta. Lisétietoja ohjelmasta 16ytyy Microsoftin Movie
Maker -sivuilta: http://www.microsoft.com/finland/products/windowsxp/moviemaker/default.mspx

Movie Makerilla tydskentely etenee kuten useimmissa editointiohjelmissa:

1. Ohjelman avaaminen

2. Projektitiedoston tallentaminen

3. Videon kaappaus (capture) tai videotiedoston tuominen (import) editointiohjelmaan

4. Videoklippien sijoittelu aikajanalle sopivaan aikajérjestykseen

5. Videoklippien leikkaaminen ja yhdistdminen erilaisilla siirtyméefekteilld (zransitions)

6. Sopivien tehosteiden lisddminen videoleikkeisiin (nopeuden muuttaminen, valoisuuden sééto
tms.)

7. Tekstien lisddminen videon alkuun, loppuun jne.

8. Videon tallentaminen sopivassa tallennusmuodossa: verkkoon, omalta koneelta katsottavaksi,
takaisin nauhalle jne.


http://www.microsoft.com/finland/products/windowsxp/moviemaker/default.mspx
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2. Ohjelman kdynnistaminen ja projektin tallentaminen

Windows Movie Maker 16ytyy tietokoneen Kéynnisté (Start) -valikosta Ohjelmat (Programs) -
kohdasta (joissain koneissa my0s polkua Kaynnistd (Starf) > Ohjelmat (Programs) > Apuohjelmat
(Accessories) > Viihde (Entertainment) > Windows Movie Maker).

Ohjelma avautuu seuraavanlaiseen ndkymaén:

1. Tyokalurivi. Toimii kuten (6 Unitied - Windows Movie Nake: 1. CoE
muissakin Windows- O ER tew Job do B b
. . D2 H [B) rasks |5 Collections | | collections
Ohjelmlssa' Collection: Collections
Movie Tasks Drag a clip and diop it on the timeline below.
o] 2
. . . 1. Capture Vide .
2. Ohjevalikko (Movie P—
Tasks) Néppari cholion®
. . . Impark audio or music
ohjevalikko, jonka mukaan |, cyiuee @
etenemadlld saat ohjeita shon s
editoinnin kussakin il ok
vaiheessa. S _ 3
3. Finish Movie (O] .
3. Collections-kokoelma,
jossa nakyvit
videoprojektissa Movic Meking Tips 1)
. o . How to capture video
kaytettavit elementit ik
N veee How to save and share mavies et =
(videot, a?net, kuvat). D HOTOE: HE
Kokoelmia (collections) B A& & @ 5| Esamsobond _ ) ]
voi olla yhdessi S B - R
. . . .. . Video = s
projektissa kiytossd o s
useampia, voit hyppia eri s '
. e . AudiofMusic
kokoelmien vililla S -
. < >
yldpuolella olevan =

pudotusvalikon avulla.
4. Videoruutu, josta voi katsella tyostettivaa videota.

5. Aikajana, jolle kasataan valmis projekti d4ni- ja videoraidalle. Aikajanalla tapahtuu videoklippien
leikkaus ja yhdistiminen.

Projektin tallentaminen

Kun Movie Maker on kdynnistynyt, valitse ylavalikosta File > Save Project As... ja tallenna
videoprojektitiedosto haluamaasi paikkaan.
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3. Videoleikkeen tuominen Movie Makeriin (Capture tai Import)

Ennen kuin mitiéin voidaan editoida, tulee projektiin siirtdd videoita videokamerasta tai omalta
koneelta. Digitaalivideokameran kytkemiseksi tietokoneeseen tarvitaan ns. FireWire-liitdnté ja -johto.
Uusissa tietokoneissa moinen liitdntd on vakiona, hieman vanhempiin sen saa erilliselld kortilla.
FireWire-liittimid on erityyppisid, sellaista joissa on hieman isompi liittimen péa ja sellaisia, joissa
liittimen pdd on pienempi. Kamerapddhén tuleva liitin on yleensi pieni.

Kun video kuvataan digitaalisella videokameralla, se tallentuu miniDV-nauhalle digitaalisessa
muodossa. Nauhalla se ei ole kuitenkaan tiedostona, vaan video tulee ensin nauhoittaa tietokoneelle
jotta sitd voidaan sen jilkeen kisitelld. Yksinkertaistettuna: piuha kamerasta tietokoneeseen ja

editointiohjelmassa painetaan Record-nappulaa!

) ) Digital Video Device

Videon kaappaaminen tapahtuu niin
= Windows can perform the same action each time paou

T . . . . I‘@ connect this device.

Liité digivideokamera tietokoneeseen FireWire-liittimen _
L . eerqe . . Wwhat do you want Windows b do™?
avulla (tietokone voi olla pailld, samoin kamera). Laita —
 eees v . . A Capture Wideo 1

nauha sisddn kamergan. Kéénna kqmera Yldeon ' L e Windons Movie Make:
katseluasennolle, laita kameraan virta. Windows tunnistaa Cantroid

. . .. e . == || Lapture Yideo
d1g1V1deokameran _]a asentaa SOprﬂl’l ajurln, tama voi uzing Microzoft Producer for FowerPoint 2.
kestdd hetken. (328 Edit and Record Video

uzing Adobe Premiere Elements
Seu.raavakm Windows kysyy mitd kameralle tehddin. @ e <
Valitse kohta Capture Video using Windows Movie Maker : —
[ shways perform the selected action
(kuva)
(]S ] l Cancel ]

Video Capture Wizard -ikkuna aukeaa (kuva). Anna 1.

kohtaan videotiedostollesi nimi ja valitse 2.
kohtaan sille tallennuspaikka. Sen jdlkeen
klikkaa Next -nappia.

(Jos Video Capture Wizard -ikkuna ei auennut,
valitse Movie Makerin Movie Tasks -valikon
Capture Movie -kohdasta Capture from video

device.)

-

-

Video Capture Wizard: Canon DV Device

Captured ¥Yideo File
Enter information for your captured video file,

1. Enter a file name For your captured video.

testividea|

2. Choose a place to save your captured video,

1) C: My Tempvideot

?

A4 Browse. .,

Nest »

] [ Cancel
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Seuraavassa vaiheessa valitaan kaapattavan videokuvan laatu:

1. Best quality for playback on my

computer. Kéytd silloin kun teet - =
113 . Video Capt Wizard: C DV Devi
tyypillisen kokoista (320x240) _— =
. Yideo Setting =
VerkkOVIdeOta' Select the setting vou want to use to capture your video, The capture setting vou select L@J
determines the quality and size of the captured video.
2' Dlgl tal devzceformat (D V_A V[) () Best quality for playback on my computer {recommended)

Paras laadultaan’ mutta Se Vie Use if you plan ko store and edit video on your computer,

luonnollisesti my®ds eniten levytilaa, | ©Riaitaldevice format (Dv-AVI)

S k . k k" e . A 11 . Use if you plan to record your final movie back ta tape.,

1ks1 kannattaa kayttaa vain silloin O ather settin

o gs

kun se on tarpeen (eli jos lopputulos

on tarkoitettu esim. DVD:lle tai Learn more about video settings.

k .. h 11 Setting details Video file: size

ta aisin nauha e)' File type: Audio-Yideo Interleaved Each minute of video saved with this setting
(AYT) will consume 178 ME.
Bit rate: 25,0 Mbps

r aha 1 3 Display size: 720 x 576 pixel
3. Other settings. Tdhin voit valita Pl e

jonkln mulsta ValmIISta asetukSISta- Video farmat: PAL Disk space available on drive C: 46,05 GE

Jos lopputulos on tarkoitettu
katseltavaksi tietokoneen nédytolta,
voit valita asetuksiksi esimerkiksi
Video for local playback (1,5 Mbps ook )ty [_Cors
PAL).

Kun olet valintasi tehnyt, paina Next -nappulaa. Seuraavassa ikkunassa voit valita, haluatko kaapata
koko nauhan vai vain osia nauhasta manuaalisesti. Hyvin harvoin on tarpeellista kaapata kaikkea
nauhan materiaalia, usein muutama tarkoin valittu patka riittdd. Siksi parempi valinta on Capture parts
of the tape manually. Seuraavassa ikkunassa voit katsella ja kelata nauhalla olevaa videota kuten
tavallisessa videonauhurissa (kuva).

Video Capture Wizard: Canon DV Device
Capture Yideo =
Click the Start Capture button to begin capturing vour video. Y'ou can capture one or more
video clips.
Skeps: Preview:

.

Stark Capture

2. Stop Capture

3. To capture another video clip,
repeat steps 1 and 2,

Video captured:  0:00:00
Size of video file: O KB

Estimated disk space available:
45,78 GE remaining on drive C: DY camera controls

L || A Al e e
Create clips when wizard finishes
[IMute speakers
Capture time [imit (hhzmm): | 2:00 [

Tape position:  0:01:33:24

< Back " Finizh ][ Cancel
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Kun olet etsinyt nauhalta sen kohdan, josta haluat aloittaa kaappaamisen, pysdytd nauha ja klikkaa Start
Capture -painiketta. Kun haluamasi patka paittyy, paina Stop Capture. Sen jélkeen etsi nauhalta
seuraavan tarvitsemasi patkén alku ja jatka samalla tavalla kunnes olet saanut kaapattua kaikki
haluamasi klipit. Sen jilkeen paina Finish-nappia.

Kaapatut videot tulevat ndkyviin Collections-kohtaan. Jos haluat kaapata lisdd videomateriaalia, valitse
Movie Tasks -valikon Capture Movie -kohdasta Capture from video device ja aloita alusta. Jokaisen
uuden kaappauskerran klipit muodostavat oman kokoelmansa, ja eri kokoelmien vililld padsee
litkkkumaan ylhéélld olevan Collections-pudotusvalikon kautta.

Tiedoston tuominen projektiin

Koneella jo olevan video-, kuva- tai ddnitiedoston voi tuoda projektiin valitsemalla Movie Tasks -
valikon Capture Movie -kohdasta Import video/pictures/audio or music.

4. Videon editoiminen
HUOM! Editointiohjelmassa kisitelldén ainoastaan viitteitd kaapattuihin video-, 4dni- yms.
tiedostoihin. Ohjelmassa tehdyt muokkaukset eivit koskaan tuhoa tai muuta alkuperéisté tiedostoa.

Muista tallentaa projektitiedostosi vililld editoinnin aikana.

Collections-kohdan materiaaleja voi

raahata hiirelld vasen ndppdin
pohjassa vetdmaélld aikajanalle.

Aikajanalla videoklippeji voi
lyhenti tai pidentdd raahaamalla
hiirelld klipin alku- tai loppukohtaa.
Tadma onnistuu viemadlla hiiri klipin
alku- tai loppureunaan jolloin hiiren
kursori muuttuu punaiseksi
kaksipéaiseksi nuoleksi. Klippid voi
tietysti pidentdd vain niin pitkille,
kun materiaalia on kaapattu
tietokoneelle.

Klippien jarjestystd voi muuttaa
raahaamalla niitd eri kohtiin
aikajanalla ja klipin voi poistaa
valitsemalla sen hiirelld ja
painamalla néppdimistoltd Delete.

5) testivideo - Windows Movie Maker

/o

{ Bl Edt View Took Cip Play Help

‘D2 v- e

Movie Tasks

1. Capture Video (&)

B 2| & &

») | F show Storyboard

Collections | testividen

Collection: testivideo
ip and drop it on the timeline below.

video. E 3.6.200.. L]
e

Transition

[C
005 GA0000 0009000 0005000 0004000 0005000 G0 0000 G100 ool

testivideo

Audio 3520061217 [ testivideo

J[ 187, [P restivides |

AudiofMusic

Title Overlay
[E3

Ready
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Katsotaan aikajanaa tarkemmin:

> B L& ] ) (#) Ll Show Storyboard

D000 0:0070,00 0:0020[ C:0030,00 000000 0005000 0010000 0011000 0:012000 0:01:30,00 0014000 0015000 0
. S i'—; T =
I .
Transition E
Awdio | 3520061217 b tectijideo 4l 197 || testivideo |
AudiofMusic
Title Cverlay v

[To add a title, select Titles and Credits from the Tools menu. |

Ready

Movie Makerissa on kdytettdvissd vain yksi videoraita ja kaksi dédniraitaa (toinen videon dénelle, toinen
muille, esim. tehoste- ja taustadénille). Lisdksi on yksi raita teksteille ja yksi klippien vilisille
siirtymille. Videon dédniraidan saa ndkyviin ja pois ndkyvistd klikkaamalla Video-sanan vieressd olevaa
plussaa tai miinusta. Aikajanalla litkkuva sininen pystyviiva osoittaa aina sen kohdan, missé video on
menossa.

— Tyokalut:

- Set Audio Levels. Tilld tyokalulla voit sddtdd videon déniraidan ja toisen déniraidan (esim.
taustamusiikin) ddnenvoimakkuutta suhteessa toisiinsa.

- Narrate Timeline. Voit spiikata omat juttusi videoiden péélle helposti.

- Zoom Timeline In/Out. Niilla tyokaluilla voit zoomata aikajanaa isommaksi tai pienemmaksi.
Suurentaminen on esimerkiksi hyddyllisté silloin kun tiytyy tehda tarkkaa tyotd. Pienentdminen
taas helpottaa hahmottamaan kokonaiskuvan.

- Rewind Timeline. Siirtdé soittimen, eli sinisen pystyviivan aina aikajana alkuun.

- Play Timeline. Pistdd videon pyoriméddn. Sama nappula muuttuu Pause Timeline -napiksi kun
video pyorii.

- Show Storyboard/Timeline. Tdstd napista voit vaihtaa nikymain joko storyboard-tyyppiseksi tai
aikajanaksi.

\

My®6s videonkatseluikkunan alapuolella on pari hyodyllistia Timeline: testivideo
tyokalua:

- Split clip. Katkaisee aikajanalla valittuna olevan klipin
sinisen pystyviivan osoittamalta kohdalta kahteen
osaan.

- Take picture. Voit ottaa still-kuvan yksittdisesté
kuvaruudusta aikajanalla.

0:00:31 44 7 0:02:10.48

Ty
Oloroocc) (6i9) (@) <«
1
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5. Efektien ja siirtymien lisddminen

Videoleikkeiden paille voi lisétéd efektejd (esim. hidastus tai mustavalkoisuus), ja leikkeiden viliin
erilaisia siirtymié (transitions).

Efektit

Valitse Movie Tasks -valikon Edit Movie -kohdasta View video effects. Tartu haluamastasi efektista
kiinni hiiren vasemmalla ndppdimelld ja raahaa se haluamasi klipin péélle aikajanalle Kun klippiin on
liitetty jokin efekti, klipin siséssé aikajanalla nikyy sininen tdhti.

Efektin poistaminen onnistuu klikkaamalla klippid aikajanalla hiiren oikealla ndppdimell4 ja
valitsemalla avautuvasta valikosta Video Effects... Avautuvasta ikkunasta voi seka lisété ettd poistaa
efektejd. Vasemmalla ndkyvit efektit, joita voi lisdtd, ja vasemmalla puolella ndkyvit ne efektit, jotka
kyseisessé klipissd on kdytossa.

Siirtymiit

Jos videoklipin raahaa aikajanalla osin edellisen leikkeen paille, niiden viélille tulee yksinkertainen
ristileikkaus (cross-fade). Muunlaisia siirtymid varten valitse Movie Tasks -valikon Edit Movie -
kohdasta View video transitions. Tartu haluamastasi efektistd kiinni hiiren vasemmalla ndppdimell4 ja
raahaa se haluamasi klipin péélle aikajanalle Siirtymé tulee tdmén ja sitd edeltdvén klipin véliin ja
nékyy klippind omalla Transitions-raidallaan. Sitd voi venyttda tai lyhentda ja sen voi poistaa samalla
tavalla kuin videonkin.

6. Tekstien lisaaminen

Valitse Movie Tasks -valikon Edit Movie -kohdasta Make titles or credits. Movie Maker kysyy mihin
kohtaan haluat tekstin sijoittaa: koko videon alkuun, ennen valittua klippid, valittuna olevan klipin
paille, valitun klipin jdlkeen vai koko videon loppuun.

@ testivideo - Windows Movie Maker [;]@

© Fle Edt Wiew Took Cip Play Help

|_'] 2 4 H| - |ETasks‘ Callections D Videa Transitions _"’_"

Enter Text for Title Fade. In and Dut
Click 'Done’ to add the title to the mavie.

TESTI-
tekstia

Dong, add title bo movie Cancel

Mare options:

Change the title animation

Playing

Change the text Fonk and color




Jyviskylédn yliopiston virtuaaliyliopistohanke
Heta Kero & Rikupekka Oksanen 2006

Sitten vaan kirjoitellaan sopiva teksti, katsellaan esikatseluikkunasta nayttddko hyvéltd, ja tarvittaessa
vaihdetaan tekstin animaatiota, fontin kokoa, vérid tms. More options -kohdasta. Kun teksti miellyttaa
silméa, klikkaa Done, add title to movie -linkkid. Teksti ilmestyy klipiksi joko Title Overlay - tai
videoraidalle, riippuen siitd, oliko se tarkoitettu videon péélle vai videoklippien alkuun, véliin tai
loppuun. Tekstiklippien lyhentdminen, pidentdminen ja poistaminen kdy samalla tavalla kuin
videoidenkin.

7. Videon tallentaminen

Movie Makerissa kuten muissakin videoeditointiohjelmissa kohdasta File > Save As... tallennetaan
vain videoprojekti, ei varsinaista videotiedostoa. Kun video on editoitu valmiiksi, se pitdd viela
erikseen tallentaa yhdeksi videotiedostoksi. Vaihtoehtoisesti videon voi my0s nauhoittaa takaisin
kameran Mini-DV-nauhalle.

Jos haluat tehda videostasi tiedoston, kannattaa Movie Tasks -valikon Finish Movie -kohdasta valita
Save to my computer.

Aukeaa ikkuna, jossa valitaan tiedoston nimi ja tallennuspaikka. Tee ndin ja paina Next. Seuraavassa
ikkunassa valitaan tallennusasetukset. Vaihtoehtoja on monia, ja tissi vaiheessa pitdd miettid videon
kéyttotarkoitusta. (Jos sinulle nékyy vain yksi vaihtoehto, klikkaa Show more choisesl.)

- Ensimmaéinen vaihtoehto Best quality for
playback on my computer on nimenséi

mukalsestl kayttpkelpomen s11}.c.)1n? jos o
videota on tarkoitus katsella p4ddasiassa Movie Setting PN
tietokoneella Tuloksena on Suurikokoinen Select the zetting vou want to use ta zave your movie. The setting you select I'\.I..‘ |
X : R R R determines the quality and file size of your saved movie, N
Windows Media Video (wmv)-tiedosto.
() Best quality For playback on my computer (recommended)
. ) . o o s
- Toisessa kohdassa Best fit to file size voit g,se“ e —_—
. . . . ) ii | Video For broadband (340 Kbps b
pakottaa lopullisen Windows Media Video | oo icue choes..
(wmv)-videotiedoston mahtumaan juuri
tiettyyn tiedostokokoon. Tdmé on
kuitenkin harvoin tarpeen.
- Other settings -kohdassa voit valita
valmiista asetuksista tarkoituksiisi e ___
L. . . . . Sekting details Iovie file size
sopivimman. Esimerkiksi verkkovideolle Fil type: Windows Medi Vidss (i) Estimated space required:
: . Ei: rate: 340 Kbps 5,93 MB
sopiva tallennuslaatu on Video for e
1 Aspect ratio: 4:3 Estimated disk space available on drive C:
broadband (512 Kbps) tql (340 Kbps).. i i
Tallennusmuotona on Windows Media
Video (wmv). Jos taas haluat tallentaa
videon parhaalla mahdollisella laadulla, (TN e

valitse tdhdn DV-AVI (PAL). Tuloksena
on erittdin suurikokoinen avi-tiedosto.
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Setting details -laatikosta néet yksityiskohtaisempaa tietoa asetuksista ja toiselta puolelta Movie file size
-kohdasta voit katsoa paljonko levytilaa pakattava tiedosto vie ja paljonko levytilaa koneessasi on
jéljella. Kun asetukset on valittu, paina Nex? ja video alkaa tallentua. Tédssd kestdd videon koosta ja
koneen tehoista riippuen hetkestd useisiin minuutteihin.

Kun tallennus on ohi, paina Finish-nappia. Jos valintalaatikossa on ruksi, juuri tekemadsi videotiedosto
kéynnistyy nyt Windows Media Playerissd ja voit katsoa tuotoksesi.

Tallenna vield viimeisin versio projektitiedostostasi Movie Makerissa ja sulje ohjelma.
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